1. Memory

There are basically two important types of RAM (Short for Random Access Memory):

1. SRAM - Static RAM, and
2. DRAM - Dynamic RAM,

SRAM, being expensive, primarily used for Cache memory. DRAM, being cheaper, is used for main memory. SRAM is widely used for Level 1, Level 2 or Level 3 cache memory. Level 1 cache is internal to the processor, and level 2 and level 3 caches are external to the processor, it resides on the motherboard.

DRAM: Dynamic RAM holds its data if it is continuously accessed by special logic called a refresh circuit. If the memory is not refreshed regularly, then the DRAM will lose its contents. This refreshing action is why the memory is called dynamic. All PCs use DRAM for their main system memory, instead of SRAM, even though DRAMs are slower than SRAMs and require the overhead of the refresh circuitry. The reason that DRAMs are used is that they are much cheaper and take up much less space.

RAM is much faster than ROM is, due to the nature of how it stores information. For this reason, RAM is often used to shadow the BIOS ROM to improve performance when executing BIOS code. PROM (Programmable ROM) is also a version of ROM and is slower compared to RAM.

The computer main memory usually consists of some type of DRAM. Types of DRAM Packages and DRAM Memory are explained below:

168 pin DIMM (SDRAM): It can run at much higher clock speeds than conventional memory. SDRAM actually synchronizes itself with the CPU's bus and is capable of running at 133 MHz and twice as fast EDO DRAM.

184 pin DIMM (DDR-SDRAM): It supports data transfers on both edges of each clock cycle, effectively doubling the memory chip's data throughput. DDR-SDRAM is also called SDRAM II. DDR stands for Double Data Rate.

240 DIMM (DDR2-SDRAM): It supports higher speeds than it's predecessor DDR SDRAM

240 DIMM (DDR3-SDRAM): It supports speeds faster than DDR2 SDRAM.
PC Memory cards:
SIMMs (Single Inline Memory Modules) have 72 pins on each side of the stick. SIMMs are 32 bits wide, and you need two 72-pin SIMM sticks (Minimum) on a Pentium class computer. This is because the bus width is 64 bits in a Pentium class computer. Note that each side of each pin on a SIMM stick is same; where as each side of each pin on a DIMM (Dual Inline Memory Module) has separate signal flowing.

A DIMM (Dual-Inline Memory Module) has two rows of connecting fingers; one row on each side, and the total number of contacts is 168 for SDRAM, 184 pins for DDR, 240 pins for DDR2 and DDR3 memories.

144-pin small outline DIMM (soDIMM) is commonly used in notebook computers. 144-pin micro-DIMM is still smaller than the so-DIMM and used in sub-notebook computers. 72-pin SODIMM was used in older laptops.

A Secure Digital (SD) card is a small memory card used to make storage portable among various devices, such as cellular phones, PDAs, digital cameras, music players, and personal computers. It uses flash memory to provide nonvolatile storage, which means that a power source is not required to retain stored data.

PCMCIA Cards:
1. Type I: 3.3 mm thick. Used for memory upgrade cards.
2. Type II: 5 mm thick. Used for modem and network cards. Some are combination Modem/NIC cards.
3. Type III: 10.5 mm thick. Used in PC card hard drives.

The two most important features of PCMCIA are its Plug and Play and Hot Swapping capabilities.

The following are usually hot pluggable devices:
   a. eSATA (even SATA is hot pluggable under XP and Vista)
   b. USB
   c. Expresscard/54

But you need to follow proper procedures if you want to remove a USB or eSATA device while the computer is on. The Personal Computer Memory Card International Association (PCMCIA) developed the both the ExpressCard standard and the PC card standards. The host device supports both PCI Express and USB 2.0 connectivity through the ExpressCard slot; cards can be designed to use either mode. The cards are hot-pluggable.
2. Display Adapters and Monitors

Monitor Connectors:

- If you are using a Monochrome / CGA/ EGA monitor, it is a digital monitor and will have a DB-9 Male connector that plugs into a digital adapter.
- If you are using a VGA/ SVGA monitor, it will have a male DB-15 connector that plugs into an analog adapter. You should never interchange an analog monitor to that of a digital adapter and vice versa, or severe damage may take place.

Video types

The table below compares various video types:

<table>
<thead>
<tr>
<th>Video monitor</th>
<th>Max. Color depth</th>
<th>Max. Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CGA</td>
<td>16 Colors</td>
<td>160X100</td>
</tr>
<tr>
<td>EGA</td>
<td>64 colors</td>
<td>640X350 (Graphics Mode)</td>
</tr>
<tr>
<td>VGA</td>
<td>256 colors</td>
<td>640X480 (Graphics Mode)</td>
</tr>
<tr>
<td>SVGA</td>
<td>16 Million Colors</td>
<td>1280X1024 or even more</td>
</tr>
</tbody>
</table>

When you are installing a different SVGA monitor, it is unlikely that the new monitor has the same capabilities as the old one. As a result, the image on the screen may not be readable. In such instances, change the video resolution to Standard VGA before installing the new monitor. You can change the resolution appropriately after the image on the screen is readable with the new monitor. It may also be necessary to load appropriate device driver, if you are installing a different display adapter.

LCD Monitors:

The ‘native resolution’ specification points out one of the big differences between LCD and CRT displays. If you run an LCD at any resolution other than its native resolution, the display will become blurry, especially with text. The reason this happens on LCDs is that they are made up of tiny cells in a matrix (called the native resolution). For instance, if the native resolution is listed as 1280×1024, then there are 1280 cells across and 1024 cells down the screen. If you only display at 1024×768, then a large number of the pixels are being ‘stretched’ over multiple cells, which is what causes the image quality to degrade.
Various resolutions commonly used with LCD monitors are as given below:

1024 x 768 is XGA (eXtended Graphics Array)
1280x720 is WGA/WXGA (Wide eXtended Graphics Array)
1280 x 1024 is SXGA (Super eXtended Graphics Array)
1400x1050 is SXGA+ (Super eXtended Graphics Array Plus)
1680x1050 is WSXGA (Wide Super eXtended Graphics Array Plus)
1600x1200 is UXGA (Ultra eXtended Graphics Array)
1920x1200 is WUXGA (Wide Ultra eXtended Graphics Array)

Wide screen format aspect ratio is typically 16:10 for computer monitors and 16:9 for LCD televisions. Aspect ratio of 16:10 conforms with WUXGA standard. Further note that UXGA has a resolution of 1600X1200 and an aspect ratio of 4:3.

Products or instrumentation equipped with a touch screen normally require a calibration routine upon power up because it is difficult to perfectly align a touch screen’s coordinates with those of the display underneath it. Calibration is necessary when the coordinates of the area touched on the screen are not sufficiently close to the coordinates on the display. Without proper calibration, software may not respond correctly when a soft button or icon is pressed. It is recommended that you clean the LCD screen with clean water, using a soft cotton cloth. Do not spray water directly on the screen. First wet the cloth (no dripping of water), and wipe the LCD screen gently.

Monitors and static charge:

1. Monitors accumulate very high static charges and need to be handled very carefully. Before attempting any repair, it is important to discharge any accumulated charges on the monitor. You can use a jumper, one end of which is grounded, and touch the other end of the jumper wire to the anode of the monitor. While doing so, ensure that you are not in direct contact with the jumper wire or the anode. You can use a screwdriver, or a nose pliers with rubber handle for this purpose. A "POP" sound can be heard when the static charges accumulated on the anode lead getting grounded through the jumper wire. Static charges accumulated on monitors may lead to severe burn or even fatal, if come into direct contact.

2. Never wear a wrist strap when working on monitors. Monitors contain very high voltages, sometimes fatal to human, even when the power is turned off. If you are wearing wrist strap, the human body works as a conduit to discharge the electric charge.
3. Floppy, CD ROM, Hard Disk

The storage capacity of various types of floppy:

<table>
<thead>
<tr>
<th>Size</th>
<th>Type</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 1/4”</td>
<td>DSHD</td>
<td>1.2MB</td>
</tr>
<tr>
<td>3 1/2”</td>
<td>DSDD</td>
<td>720KB</td>
</tr>
<tr>
<td>3 1/2”</td>
<td>DSHD</td>
<td>1.44MB</td>
</tr>
<tr>
<td>3 1/2”</td>
<td>DSED</td>
<td>2.88MB</td>
</tr>
</tbody>
</table>

A floppy cable will have 34 wires, and the wire with red stripe signifies wire going to pin number 1 of the connector.
The floppy ribbon cable is distinguished easily from that of an IDE cable by a small twist in the cable. The purpose of the twist is to differentiate between floppy drive A and floppy drive B

**Characteristics of a floppy drive:**

1. The ribbon cable connecting the floppy drive to the motherboard is 34 wires wide.
2. There can be a maximum of two floppy drives in a PC

When you have two hard disk drives, the following two combinations are possible:

1. Install the drives one each on primary and secondary controllers and designate both as Masters.
2. Install both the drives on the primary controller and designate one as Master and the other as Slave.

**CD-R** stands for CD-Recordable. You can record data onto a CD-R only once. **CD-RW** stands for CD-Rewritable, and as the name suggests, you can record data any number of times onto a CD-RW (subject to wear and tear). CD-R is represented by two speeds (AxB), the former is the write speed and the latter is the read speed. The read speed is always higher than the write speed. Some typical CD-R speeds are as given below:
4X24,
8X32,
16X32 etc.

**DVD**, also known as Digital Versatile Disc or Digital Video Disc, is an optical disc storage media format. Its main uses are video and data storage. DVDs are of the same dimensions as compact discs (CDs), but store more than six times as much data.
DVD comes in single layer (SL) or dual layer (DL). They are also distinguished as single sided (SS) or double sided (DS). There are four possible combinations:

- **DVD-S (12 cm, SS/SL):** 4.37 GB capacity
- **DVD-9 (12 cm, SS/DL):** 7.95 GB capacity
- **DVD-10 (12 cm, DS/SL):** 8.74GB capacity
- **DVD-18 (12 cm, DS/DL):** 15.90GB capacity.

Further, DVD-S stores about two hours of video, whereas DVD-18 can store up to eight hours of video.

**MS –DEFRAG utility:**

To defragment the hard disk, you can run Microsoft defragment utility by issuing a command "DEFRAG".
4. CPU

Processor package types:
- 8088, 8086 processors used 40 pin DIPs. 80286, 80386, 80486, and some Pentium computers (60MHz, 66MHz) used PGA (Pin Grid Array).
- Pentium chips (75 MHz and above) used SPGA (Staggered PGA). Pentium II CPUs use cartridge type mounting method, called "slot-1".

CPUs and features:

<table>
<thead>
<tr>
<th>Processor</th>
<th>Socket type</th>
<th>Register</th>
<th>Data Bus</th>
<th>Address Bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>8088</td>
<td>DIP</td>
<td>16 bit</td>
<td>8 bit</td>
<td>20 bit</td>
</tr>
<tr>
<td>80286</td>
<td>LLC/PGA/PLCC</td>
<td>16 bit</td>
<td>16 bit</td>
<td>24 bit</td>
</tr>
<tr>
<td>80386SX</td>
<td>PGA</td>
<td>32 bit</td>
<td>16 bit</td>
<td>24 bit</td>
</tr>
<tr>
<td>80386DX</td>
<td>PGA</td>
<td>32 bit</td>
<td>32 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>80486SX</td>
<td>PGA</td>
<td>32 bit</td>
<td>32 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>80486DX</td>
<td>PGA/SQFP</td>
<td>32 bit</td>
<td>32 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>Pentium</td>
<td>Socket 5 SPGA/Socket 7 SPGA.</td>
<td>64 bit</td>
<td>64 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>Pentium Pro</td>
<td>Socket 8 SPGA</td>
<td>64 bit</td>
<td>64 bit</td>
<td>32 bit</td>
</tr>
<tr>
<td>Pentium II</td>
<td>SEC Slot 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pentium III</td>
<td>SECC-2/PPGA or FC-PGA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pentium IV</td>
<td>socket 423/socket 478/ socket 775</td>
<td>64</td>
<td>64</td>
<td>36 bit*</td>
</tr>
<tr>
<td>Pentium Dual Core</td>
<td>Socket 775 (LGA775)</td>
<td>64</td>
<td>64</td>
<td>64 bit*</td>
</tr>
</tbody>
</table>
* 32-bit operating systems like Windows XP can support only 32 bits of addressing space, and hence only 4GB of memory can be used. By using 64-bit operating systems, 16 Exa bytes (EB) of RAM can be used. 36 bits of address space can access up to 64GB of memory.

CPU models 80486SX, and above contain on board cache memory.

<table>
<thead>
<tr>
<th>Address Bus Size</th>
<th>Maximum RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 bits</td>
<td>4GB</td>
</tr>
<tr>
<td>36 bits</td>
<td>64GB</td>
</tr>
<tr>
<td>40 bits</td>
<td>1TB.</td>
</tr>
<tr>
<td>44 bits</td>
<td>16TB</td>
</tr>
<tr>
<td>64 bits</td>
<td>16 EB (Exa Bytes)</td>
</tr>
</tbody>
</table>

**Bits and Bytes:**

1 KB = 1024 bytes  
1 MB = (1024 X 1024) bytes  
= (1024X 1 KB) bytes  
= 1,048,576 bytes  
1 GB = (1024 X 1024 X 1024 )bytes  
= (1024 X 1 MB) bytes  
= (1024 X 1024 X 1 KB) bytes  
= 1,073,741,824 bytes  
KB stands for Kilobyte  
MB stands for Megabyte  
GB stands for Gigabyte  
Byte is represented by "B" as in MB  
Bit is represented by "b" as in kbps  
One byte is 8 bits

The Slot 1 package replaces the Socket 7 and Socket 8 used by previous Pentium processors. Slot 1 is a 242-contact daughter card slot that accepts a microprocessor packaged as a Single Edge Contact
(SEC) cartridge. A motherboard can have one or two Slot 1s. More recently, Slot 2 package has been
developed and used by recent processors.

**FAT file system:**

Under FAT file system, the maximum size of a cluster is 32 KB and the maximum number of clusters
is 65536. Therefore, the maximum size of a partitions is the number of clusters multiplied by the max
size of the cluster, which is equivalent to 2 GB. Remember that 1 KB = 1024 bytes.

New Technology File System (NTFS) is a file system that was introduced by Microsoft to provide
superior features like encryption, compression, and user permissions. NTFS is the primary file system
used in Microsoft's Windows NT, Windows 2000, Windows XP, Windows 2003, Windows Vista, and
Windows 7 operating systems.

5. **Keyboard**

**Keyboard connectors:**

Key boards come with two types of connectors. They are:

1. DIN-5, DIN-5 has 5 pins and used with AT style keyboards.
2. Mini DIN-6, also known as PS/2 connector, has around port with 6 pins, one of which being a
   square pin used for alignment.

6. **Power Supply**

**DC voltages commonly found in a PC:**

- +5, and +12 volts are the DC voltages commonly found on PCs. 80386 / 486 operate at +5v
- Pentium and above operate at +3.3v
- Power supply wires - yellow=+12v, blue=-12v, red=+5v, & white=-5v

One good way of determining a bad power supply is that the fan will not rotate. Also, the computer
will not boot and the LED s indicating the power and disk activity will be OFF.

**ATX12V 2.0 power supply provides four different voltages:**

3.3Volts, 5Volts, 12Volts and -12Volts. Previous versions of ATX12V used to provide -5V, and it has
been discontinued in version 2.x.
Uninterrupted Power Supply (UPS):

An UPS is required for any critical and un-interrupted use of computers. It has the following benefits:
1. Provide protection against small surges
2. Filters noise from entering the computer
3. Provide power to the computer during line power failure
4. Give stable power to computer, even when the line power is unstable.

Note that the UPS can give un-interrupted power only for a fixed amount of time under a given load, in the absence of line voltage.
7. Printers and cables:

Laser printers:
The following are the 6 steps in the ElectroPhotographic (EP) print process of Laser Printer:

1. Cleaning: Cleaning the photosensitive drum includes residual toner left on the drum and removing the electrical charges left out on the drum. The physical cleaning is done with a rubber blade and the electrical charge cleaning is done with erasure lamps.
2. Charging: The next step in printing, is to charge the photo sensitive drum with high negative charge, this is done with the help of a corona wire.
3. Writing: A laser (type 3) sweeps the entire length of the drum, creating the static image of the matter to be printed. The places where the laser travel, the highly charges are neutralized. Other places of the drum, it remains highly negatively charged.
4. Developing: Now drum gets in close proximity to the toner. Because the toner is negatively charged, it gets attracted to the areas where the drum is neutral. It will not be attracted to the places where the drum is highly negatively charged. Thus the image of the page to be printed formed on the photosensitive drum.
5. Transferring: Now, the toner on the drum gets attracted toward the paper, by using highly positive charges developed on the surface of the paper. The "transfer corona" is used to generate highly positive charge on the paper surface and to attract the toner from the drum. Thus the image of the page to be printed formed on the paper. But still, the toner is loose and can get easily smeared.
6. Fusing: In order to permanently bond the toner particles to the paper, the paper is passed through rollers. One of the rollers, the non stick roller is heated by a high intensity lamp, generating the heat necessary to bond the toner to the surface of the paper.

Problems associated with laser printers and probable causes:

1. Speckled pages: The causes for this may be
   a. The failure to clean the drum after printing properly, or
   b. The drum might have developed scratches.
2. Blank pages: The causes for white pages may be, A. The toner would have dried out, replace the toner. B. The transfer corona, that is responsible for transferring the toner to the drum might have failed. C. The High Voltage Power Supply (HVPS) failure will also result in white pages.
3. Ghosted Images: Ghosting occurs when previously printed pages are printed again, though much lighter than the present image. The most likely cause is that the erasure lamp might not be working properly, thus leaving some charges representing the earlier image left on the photosensitive drum before new image is written. Also check the cleaning blade, which is responsible for scaping the residual toner.
4. Smudged images: If the fusing fails, the toner will not bond with the paper. Check the halogen lamp responsible for heating.
Impact printers are capable of printing multipart forms, since they can give necessary impact to print to multiple forms simultaneously. ECP (Extended Capability Port) has less control overhead and best suited for transferring large chunks of data, such as between the computer and laser printer.

InkJet Printers is the generic name given for contactless printing using ink. Friction feed is most commonly used with laser printers, and Inkjet printers.

Printer parallel ports come in the following varieties:

1. Unidirectional: Here, the data travels only from the computer to the peripheral (printer) device.
2. Bi-directional: Here, the data travels both from the computer to the peripheral device and vice-versa.
3. ECP (Extended Capability Port): ECP mode offers bi-directional data transfer, as well as DMA for data transfer.
4. EPP (Enhanced Parallel Port): In addition to bi-directional features, it offers an extended control code set.

The port that a printer is using can be found by going to Control Panel -> Printers and right click on appropriate printer. Choose Ports tab to view the port (like COM1, COM2, USB001, etc.) that the printer is using.

Cable lengths:

- Serial cable maximum length is 50 feet.
- Parallel cable maximum length is 10 feet.
- Longer cable lengths may lead to some errors & garbage characters.

RJ – cables:

1. RJ-11: These connectors are used to link modem / phone to the phone line. They have only two pins that get into the modem.
2. RJ-14: RJ-14 connectors are dual-line phone jacks that can accommodate up to 2 telephone line.
3. RJ-45: RJ-45 cable is widely used for attaching UTP cable in LAN environment. These connectors have eight pins.

The widely used interface cables have the following pin count:

1. floppy-34 pin,
2. IDE-40 pin,
3. SCSI-50 pin,
4. SCSI Ultra wide-68 pin

Ultra IDE cable has 80 wires, and handles better speeds compared to IDE cable with 40 wires. The additional wires are introduced to reduce noise and thereby improving speed.

Thin co-axial and thick co-axial cables have conductive grounding sheath surrounding the center conductor. Therefore, the electromagnetic interference (EMI) is significantly less.
Cat 6 cabling is recommended for Gigabit Ethernet networking.

Centronics cable, used for parallel printing will have a male DB-25 connector at one end and a female 36 pin connector at the other end.

When communicating across a serial cable, the most probable cause that the screen is dumping garbled characters is that the communication settings are not correct. Check the speed, parity, start/stop bits etc. If this is all correct, then you need to check the cable. Check whether you need a straight / cross cable, and the pin connections.
8. Networking

Most commonly used network devices are hubs, switches (or bridges), and routers.

Router: A router for Internet sharing is normally configured using web browser. High-end routers may provide option for terminal connectivity, wherein you can connect a terminal, and issue commands for configuring the router.

Hub: A hub is basically a multi-port repeater. When it receives a packet, it repeats that packet out each port. This means that all computers that are connected to the hub receive the packet whether it is intended for them or not. It's then up to the computer to ignore the packet if it's not addressed to it. This might not seem like a big deal, but imagine transferring a 50 MB file across a hub. Every computer connected to the hub gets sent that entire file (in essence) and has to ignore it.

Bridge: A bridge is a kind of repeater, but it has some intelligence. It learns the layer 2 (MAC) addresses of devices connected to it. This means that the bridge is smart enough to know when to forward packets across to the segments that it connects. Bridges can be used to reduce the size of a collision domain or to connect networks of differing media/topologies, such as connecting an Ethernet network to a Token Ring network.

Switch: A switch is essentially a multi-port bridge. The switch learns the MAC addresses of each computer connected to each of its ports. So, when a switch receives a packet, it only forwards the packet out the port that is connected to the destination MAC address. Remember that a hub sends the packet out every port, and you can see how much more efficient this is.

Ethernet:
- 10BaseT Ethernet complies to IEEE standard 802.3 and requires an RJ-45 connector to connect to the NIC. The maximum specified transmission speed for 10BaseT Ethernet is 10Mbps. For 100BaseT, it is 100Mbps.
- 802.11b operates at 2.4 GHz, while 802.11a operates at 5 GHz. Typical data rate for 802.11b is 11 Mbps where as it is 54mbps for 802.11a.
- 802.11b is compatible with 802.11g. 802.11a operates at 5 GHz, and is not compatible. Bluetooth is entirely a different protocol standard
- Ethernet is based on CSMA/CD, which stands for Carrier Sense Multiple Access / Collision Detect.
- CAT3, CAT4 or, CAT5 cabling is used with 10BaseT Ethernet. Thin coax is used with 10Base2 Ethernet. Thick coax is used with 10Base5 Ethernet. FDDI uses Optic Fiber as the medium.
- 10Base2 network, also known as Thin-net, uses BNC connector to connect to the NIC.
- A repeater can extend the distance over which the signal can travel without lossing out due to attenuation.
- The maximum length of the cable for 10BaseT Ethernet segment is 100 meters.
- Thin co-axial and thick co-axial cables have conductive grounding sheath surrounding the center conductor. Therefore, the electromagnetic interference (EMI) is significantly less.

**Token Ring** supports 4 Mbps and 16 Mbps speeds.

IRQs, and IRQ/IO conflicts

<table>
<thead>
<tr>
<th>IRQ</th>
<th>Standard Device Assignment</th>
<th>I/O Port Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>System timer</td>
<td>40Hex</td>
</tr>
<tr>
<td>1</td>
<td>Keyboard</td>
<td>60Hex</td>
</tr>
<tr>
<td>2</td>
<td>Cascade to IRQ9. Can't be used.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>COM ports 2 and 4</td>
<td>COM4:2E8-2EF COM2:2F8-2FF</td>
</tr>
<tr>
<td>4</td>
<td>COM ports 1 and 3</td>
<td>COM3:3E8-3EF COM1:3F8-3FF</td>
</tr>
<tr>
<td>5</td>
<td>Parallel Port LPT2. Very often used for sound cards.</td>
<td>LPT2:278-27F</td>
</tr>
<tr>
<td>6</td>
<td>Floppy drive controller</td>
<td>3F0-3F7</td>
</tr>
<tr>
<td>7</td>
<td>Parallel Port, LPT1</td>
<td>LPT1:378-37F</td>
</tr>
<tr>
<td>8</td>
<td>Real time clock</td>
<td>70Hex</td>
</tr>
<tr>
<td>9</td>
<td>Unassigned (Also redirected from IRQ2)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Available</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Available. SCSI adapter will normally use this IRQ.</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Available</td>
<td></td>
</tr>
</tbody>
</table>
To determine the COM port assignments, or which COM ports are being used for what, you can use any of the following commands:
1. MODE command
2. DEBUG command
3. MSD
4. Corresponding device applet in the control panel

**AT Computer interrupt controllers:**

An AT computer will have two interrupt controllers. The second interrupt controller need to deliver the interrupts through the primary interrupt controller. IRQ2 had been identified for this purpose on the primary and IRQ9 on the secondary interrupt controllers. In other words, IRQ2 and IRQ9 are cascaded.

**Serial Interfaces:**

COM1, COM2 on a computer uses serial cable. The pin assignments are shown below. The computer acts as a DTE (Data Terminal Equipment) and the Modem acts as DCE (Data Communication Equipment).
Normally, a DTE device connects to a DCE device. If you want to connect two DTR devices, as you would do to hook up two computers via the serial line to exchange files, the cable itself must have cross connections. Such a cable is called null modem cable.

**Most commonly used modem commands:**

- **ATA-** Answer the phone
- **ATD-** Dial the phone, ATDT for Tone dialing, ATDP for Pulse dialing
- **ATH-** Hang up
- **ATZ-** Reset
- **AT&F-** Reset modem parameters and settings to factory defaults
- **AT&W-** Write the current parameter values and settings

On a Vista computer, when you connect for the first time to a network, you need to choose a network location. There are two network locations: Home/Work, and Public place. If the computer is shared within home office or small work place, Home/Work option is recommended. If your computer is in a public place or a large network, Public option is recommended.

If your computer is part of a domain, you won't be able to change the network location type because it is controlled by your network administrator. Network location may be changed as below:

1. Log on to the network.
2. Open Network and Sharing Center by clicking the Start button Picture of the Start button, clicking Control Panel, clicking Network and Internet, and then clicking Network and Sharing Center.
3. Click Customize, and then click either Public (for "Public place" networks) or Private (for "Home" or "Work" networks). Administrator permission required If you are prompted for an administrator password or confirmation, type the password or provide confirmation.
4. Click Next and then click Close.

**DNS** stands for Domain Name System Server. DNS Server is the one responsible for converting the Domain names to IP addresses.

**NIC**, Network Interface Card is the one that interfaces your PC to the LAN. NIC sits in your PC on one of the slot available on the motherboard.

**Attenuation**: When signals are transmitted over long distance, there will be ohmic losses, which result in losing the strength of the signals. This is known as attenuation. Amplification is opposite of attenuation.

**Asynchronous serial communication** uses Start bit/Data bits/Stop bit. A modem connecting to the Internet is a typical asynchronous device. Synchronous communication uses clock signals to transfer information. Does not use start/stop bits. Synchronous communication is normally used for high speed data transfers.

**TCP/IP** is the medium of transport when you are accessing the Internet.

**ISDN**: ISDN BRI (Basic Rate Interface) will have two B channels, each can carry data up to 64Kbps, aggregating to 128 Kbps.

**Peer-to-peer model** is best suited when you need to share files and folders among others in your office. If the number of networked computers becomes very large or if the security of data is very important, Client-Server model is recommended.

**The SPDF** - Sony/Phillips Digital Interface is designed to transfer digital signals between devices without degrading the signal by converting it to analog. This preserves the quality of the signal delivered to digital recording and playback devices.

**Wireless Networking**

The generic standard that defines wireless LAN technologies is 802.11. Specifically, the following standards exist:

a. 802.11: applies to wireless LANs and provides 1 or 2 Mbps transmission in the 2.4 GHz band.

b. 802.11a: an extension to 802.11 that applies to wireless LANs and provides up to 54 Mbps in the 5GHz band.

c. 802.11b (initially referred to as 802.11 or Wi-Fi): an extension to 802.11 that applies to wireless LAN and provides up to 11 Mbps transmission in the 2.4 GHz band.

d. 802.11g: applies to wireless LANs and provides 20+ Mbps in the 2.4 GHz band.

**Bluetooth** is widely used for communication between smart phones and other accessories or between PDAs and information kiosks. The typical coverage for Bluetooth devices is up to 30 feet. It can be used for personal area networking devices like keyboards and headphones.

**SSID**, short for service set identifier, a unique identifier attached to the header of packets sent over a
WLAN. The SSID differentiates one WLAN from another, so all access points and all devices attempting to connect to a specific WLAN must use the same SSID. WEP together with SSID, provides basic protection for the wireless network.

**WPA**, short for Wi-Fi Protected Access, is a Wi-Fi standard that was designed to improve upon the security features of WEP (Wired Equivalent Privacy). The technology is designed to work with existing Wi-Fi products that have been enabled with WEP.

**WEP**, short for Wireless Equivalent Protection, is a security protocol designed to provide protection equivalent to wired LANs. WPA is an improved security protocol compared to WEP.
9. Operating System

Windows 2000

Windows 2000 Operating systems support 5 different volume types:
1. Simple volumes
2. Spanned volumes
3. Striped volumes
4. Mirrored volumes
5. RAID-5 volumes

- A simple volume consists of a formatted disk on a single hard disk.
- A Spanned volume consists of disk space on more than one hard disk.
- A Striped volume has disk space on 2 or more disks. The disk spaces must be same on all disks. Fastest disk access among all volume types. RAID level 0.
- A mirrored volume consists of a Simple volume that is mirrored in total, onto a second dynamic disk. Provides highest level of fault tolerance. RAID level 1
- A RAID-5 volume consists of identical sized disk space located on three or more dynamic disks. Here any single disk failures can be recovered. RAID level 5.


Windows XP

In Windows XP computer, you can use Start -> Windows Update to connect to the Microsoft site. Windows Update is a catalog of items such as drivers, patches, the latest help files, and Internet products that you can download to keep your computer up to date. You must be logged on as an administrator or a member of the Administrators group in order to access the Product Updates section of Windows Update for downloading help files.

XP Professional supports multiple processors, multiple monitors (up to 9), Group Policy, Encrypting File System, Dynamic Disks, IIS, a built in backup program, and advanced networking capabilities (such as IPSec.) All of these features are missing from XP Home Edition. Another important distinction between the two versions is that XP Home Edition cannot join a Windows NT/2000/2003 domain.

Windows XP Operating System comes in the following flavours:

a. Windows XP Home: The basic XP OS intended for home users,
b. Windows XP Professional: The XP OS intended for business users,
c. Windows XP Media Center Edition: Windows Media Center provides a large-font, remotely accessible interface ("10-foot user interface") for television viewing on the computer as well as recording and playback, a TV guide, DVD playback, video playback, photo viewing, and music playback.
d. Windows XP Table PC: This edition is intended for specially-designed notebook/laptop computers called tablet PCs. Windows XP Tablet PC Edition is compatible with a pen-sensitive screen, supporting handwritten notes and portrait-oriented screens.

Boot process (F8) in Windows XP desk top bring up the following options:

* Safe Mode: This option uses a minimal set of device drivers and services to start Windows. The drivers loaded with Safe Mode include mouse, monitor, keyboard, hard drive, and standard video driver.
* Safe Mode with Networking: This option uses a minimal set of device drivers and services to start Windows together with the drivers that you must have to load networking.
* Safe Mode with Command Prompt: This option is the same as Safe mode, except that Cmd.exe starts instead of Windows Explorer.
* Enable VGA Mode: This option starts Windows in 640 x 480 mode by using the current video driver (not Vga.sys). This mode is useful if the display is configured for a setting that the monitor cannot display.
  Note Safe mode and Safe mode with Networking load the Vga.sys driver instead.
* Last Known Good Configuration: This option starts Windows by using the previous good configuration.
* Directory Service Restore Mode: This mode is valid only for Windows-based domain controllers. This mode performs a directory service repair.
* Debugging Mode: This option turns on debug mode in Windows. Debugging information can be sent across a serial cable to another computer that is running a debugger. This mode is configured to use COM2.
* Enable Boot Logging: This option turns on logging when the computer is started with any of the Safe Boot options except Last Known Good Configuration. The Boot Logging text is recorded in the Ntbtlog.txt file in the %SystemRoot% folder.
* Starts Windows Normally: This option starts Windows in its normal mode.
* Reboot: This option restarts the computer.
* Return to OS Choices Menu: On a computer that is configured to starting to more than one operating system, this option returns to the Boot menu.

You can configure support for multiple displays on your Windows XP computer. This is done through the use of Control Panel -> Display -> Settings. A Windows XP computer can support up to ten display monitors at the same time. Use additional video cards as required.

The Device Manager (It can be accessed using Add/Remove Hardware in XP) lists all the hardware
devices installed on your system. You can also update any existing drivers, as well as change the
hardware settings. You use Add/Remove Hardware to install new hardware. Accessibility options are
primarily used to configure the keyboard, display, and mouse options on a computer to accommodate
the users who are physically handicapped. The Add/ Remove Programs is used to install/uninstall 3rd
party software. This is also used for installing/uninstalling Windows XP optional components.

**Features supported by XP:**

On readable/writable disks, Microsoft Windows XP Professional supports the NTFS file system and
three file allocation table (FAT) file systems: FAT12, FAT16, and FAT32. On CDROM and DVD
media, Windows XP Professional supports two file systems: Compact Disc File System (CDFS) and
Universal Disk Format (UDF).

While installing XP, if you have a standard desktop PC that uses integrated drive electronics (IDE)
disk drives, these will be detected during setup. If, however, you use SCSI disks or have
Redundant Array of Independent Disk (RAID) storage systems, you will see, shortly after the reboot,
the following line of text displayed at the bottom of the screen:
“Press F6 if you need to install a third party SCSI or RAID driver...”

Pressing F6 will start a dialog that allows you to configure and install the drivers for your SCSI or
other disk subsystem controllers. This option is usually used on server platforms that use large-
capacity, high-speed, fault-tolerant disk subsystems. For most PCs, however, you won't need to use
this option.

**Windows Vista**

Certain versions of Windows Vista uses BitLocker Drive Encryption. BitLocker Drive Encryption is a
full disk encryption feature included with the Ultimate and Enterprise editions of Microsoft’s Windows
Vista and Windows 7 desktop operating systems.

In order for BitLocker to operate, the hard disk requires at least two NTFS-formatted volumes: one for
the operating system (usually C:) and another with a minimum size of 100MB from which the
operating system boots. BitLocker requires the boot volume to remain unencrypted, so the boot should
not be used to store confidential information.

Windows Sidebar is a pane on the side of the Microsoft Windows Vista desktop where you can keep
your gadgets organized and always available. Gadgets are mini programs that give you information at
a glance and provide access to frequently used tools. Windows Sidebar helps you to organize your
gadgets. The Windows sidebar is also available in Windows 7 Operating System.
Aero Interface

Windows Vista and Windows 7 feature a user interface termed as Aero by Microsoft. This is the default interface used by Vista. Aero interface is characterized by the following features:

1. Glass-like translucent design
2. Dynamic windows: When you minimize a window, it animates to its place on the taskbar, so it's easier to find when you need it.
3. High dots-per-inch (dpi) support: Windows Aero supports high-resolution monitors, so you can get a laptop or flat-screen monitor that's smaller in size but shows visually richer, displaying high-resolution, easy-to-read images.
4. Live taskbar thumbnails: In Windows Aero, live taskbar thumbnail images display the actual contents of both windows that are currently open and those that are minimized in the taskbar. When you rest your mouse pointer on a tile on the taskbar, you'll see the "live" contents of that window without having to bring it to the foreground.

Other features include Windows Flip 3D, and smooth scrolling desktop.

Windows Vista Home Basic, Vista Home Premium, and Vista Starter provide only limited support for EFS (Encrypted File System), whereas Vista Business, and Vista Ultimate provide full support for EFS.

Upgrade to Windows Vista Ultimate
You can upgrade to Windows Vista Ultimate from Windows XP Home, XP Professional, XP Media Center, and XP Tablet PC, Windows 2000 Professional can't be upgraded to Windows Vista directly.

The following reserved characters can't be used in Windows file names:

< (less than)
> (greater than)
: (colon)
" (double quote)
/ (forward slash)
\ (backslash)
| (vertical bar or pipe)
? (question mark)
* (asterisk)
10. Computers

**PDA:** Handheld PCs are also referred to as Personal Digital Assistants (PDAs).

**Laptops:**
- Nickel Cadmium battery is not environmentally friendly and not as efficient as Nickel / Metalhydride or Lithium Ion. Nickel / Metal hydride, though environmentally friendly, not as efficient as Lithium Ion. Lithium Ion battery is environmentally friendly and very efficient.
- Passive matrix displays are most commonly used and cheaper than Active matrix displays. Also, passive matrix displays consume less power. However, the advantages of active matrix display are that they can handle faster screen image transition, and display is clearly viewable, even from slant angles.
- Laptops most widely use PCMCIA cards, also referred to as PC cards. Normally, desktop processors consume higher power compared to laptop processors. Laptop processors are optimized for lesser power consumption, so that the heat produced is also less. This is to take care of poor ventilation conditions in a laptop computer.

**General PC error codes and probable causes:**

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>100-199</td>
<td>System board failures</td>
</tr>
<tr>
<td>200-299</td>
<td>Memory failures</td>
</tr>
<tr>
<td>300-399</td>
<td>Key board failures</td>
</tr>
<tr>
<td>400-499</td>
<td>Monochrome video problems</td>
</tr>
<tr>
<td>500-599</td>
<td>Color video problems</td>
</tr>
<tr>
<td>600-699</td>
<td>Floppy disk errors</td>
</tr>
<tr>
<td>1700-1799</td>
<td>Hard disk problems.</td>
</tr>
</tbody>
</table>

Some of the frequently encountered error codes and their corresponding error messages are given below:

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>161</td>
<td>CMOS battery failure: Replace the CMOS battery</td>
</tr>
<tr>
<td>164</td>
<td>Memory size error : If the error occurs after memory upgrade, run SETUP program.</td>
</tr>
<tr>
<td>201</td>
<td>Memory test failed : RAM chips failed, one or more may need to be replace.</td>
</tr>
<tr>
<td>301</td>
<td>Keyboard error: You may have to check the key board</td>
</tr>
</tbody>
</table>
11. Motherboard

Given below are important bus types and their characteristics:

<table>
<thead>
<tr>
<th>Bus Type</th>
<th>Data bus width</th>
<th>Speed</th>
<th>Bandwidth</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISA</td>
<td>16-bit</td>
<td>8.3MHz</td>
<td>15.9MBPS</td>
<td>Use jumpers to configure</td>
</tr>
<tr>
<td>EISA</td>
<td>32-bit</td>
<td>8.3MHz</td>
<td>31.8MBPS</td>
<td>Backward compatible with ISA, uses software/jumpers for config</td>
</tr>
<tr>
<td>VESA or VL bus</td>
<td>32-bit</td>
<td>33MHz</td>
<td>127.2MBPS</td>
<td>Backward compatible with ISA cards</td>
</tr>
<tr>
<td>PCI</td>
<td>32-bit</td>
<td>33MHz</td>
<td>127.2MBPS</td>
<td>Supports Plug and Play</td>
</tr>
<tr>
<td>64-bit PCI</td>
<td>64-bit</td>
<td>66MHz</td>
<td>508.6MBPS</td>
<td>Supports Plug and Play</td>
</tr>
<tr>
<td>PCMCIA</td>
<td>32-bit</td>
<td>33MHz</td>
<td></td>
<td>Used in laptops, also know as PC card</td>
</tr>
<tr>
<td>AGP</td>
<td>32-bit</td>
<td>Speed of Processor</td>
<td></td>
<td>Used in video cards</td>
</tr>
</tbody>
</table>

Common Buses and their Max Bandwidth

<table>
<thead>
<tr>
<th>Common Buses</th>
<th>Max Bandwidth</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCI</td>
<td>132 MB/s</td>
</tr>
<tr>
<td>AGP 8X</td>
<td>2,100 MB/s</td>
</tr>
</tbody>
</table>
PCI

PCIe busses for 3x and 5x are not available. Since PCI Express is a serial based technology, data can be sent over the bus in two directions at once. Normal PCI is Parallel, and as such all data goes in one direction around the loop. Each 1x lane in PCI Express can transmit in both directions at once. In the table the first number is the bandwidth in one direction and the second number is the combined bandwidth in both directions. Also please note that in PCI Express bandwidth is not shared the same way as in PCI, so there is less congestion on the bus.

Firewire

A standard FireWire connection will support 100,200 and 400 Mbps. The important features of IEEE1394 (also known as FireWire 400) are:

1. 100 Mbit/s, 200Mbit/s, and 400Mbit/s supported.
2. Works without control, devices communicate peer-to-peer.
3. Cable up to 4.5 m.
4. Up to 63 devices supported.
5. Power supply to external devices is 1.25A/12V (max.).
6. The only computer bus used in digital video cameras
The IEEE 1394b specification supports data rates up to 400 Mbit/s in half-duplex mode, and even higher in full duplex. It can support optical connections up to 100 metres in length.

**SCSI Types:**

<table>
<thead>
<tr>
<th>SCSI Type</th>
<th>Transfer speed</th>
<th>Bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCSI-1</td>
<td>5MBPS</td>
<td>8 bit bus</td>
</tr>
<tr>
<td>Fast Wide SCSI</td>
<td>20MBPS</td>
<td>16 bit bus</td>
</tr>
<tr>
<td>Wide Ultra SCSI</td>
<td>40MBPS</td>
<td>16 bit bus</td>
</tr>
<tr>
<td>Ultra2 SCSI</td>
<td>40MBPS</td>
<td>8 bit bus</td>
</tr>
<tr>
<td>Wide Ultra2 SCSI</td>
<td>80MBPS</td>
<td>16 bit bus</td>
</tr>
<tr>
<td>Ultra3 SCSI or Ultra 160</td>
<td>160MBPS</td>
<td>16 bit bus</td>
</tr>
<tr>
<td>Ultra320</td>
<td>320 MBPS</td>
<td>16 bit bus</td>
</tr>
</tbody>
</table>

SCSI ID - 0=bootable drive, 7=controller, 1-6=any other devices
Wide-Ultra SCSI - 16 devices, 0=bootable drive, 15=controller

Each device in a SCSI chain need to have unique ID. For a 16-bit Wide SCSI, there are 16 possible SCSI Ids, 0-15. A standard 8-bit SCSI can support only 8 devices (including SCSI card), the Ids allowed are 0-7.
SCSI bus termination:
If the termination is not done, a SCSI devices on the bus will not function properly. This is due to reflection of the signals at the end of the bus. To prevent this, both ends of the SCSI bus need to be terminated. If one end of the SCSI bus is terminated, you may find intermittent problems. Never terminate the bus at a device connected in between.

USB (Universal Serial Bus):
- USB supports up to 127 devices simultaneously.
- USB enables you to daisy chain up to 127 USB devices. A USB hub is used for this purpose. Also, USB devices can be plugged in without turning on/off power. i.e, USB devices are hot swappable.

USB 2.0
The important features of USB 2.0 are given below:

1. 1.5 Mbit/s 12Mbit/s 480Mbit/s supported.
2. USB controller is required to control the bus and data transfer.
3. Cable up to 5 m.
4. Up to 127 devices supported.
5. Power supply to external devices is 500 mA/5V (max).
6. Full compatibility with USB 1.1 devices.

To achieve proper USB connectivity six basic system elements must be present

1) Support from the BIOS
2) Support from the Operating System
3) Physical USB ports
4) A USB Device
5) The correct USB cable for the device
6) Drivers either from the OS and/or the peripheral maker

USB 2.0 has a raw data rate at 480Mbps, and it is rated 40 times faster than its predecessor interface, USB 1.1, which has 12Mbps max speed.

External Serial Advanced Technology Attachment or eSATA is an external interface for SATA technologies. It is faster compared to USB 2.0 or PATA technologies, and suitable for backing up large amounts of data using external hard drive.

Even though eSATA is part of the SATA interface specifications, it uses a very different physical connector from the internal SATA connectors. The reason for this is to better shield the high speed serial lines used to transfer the signals from EMI protection. It also provides a 2m overall cable length compared to the 1m for internal cables. As a result the, the two cable types cannot be used.
interchangeably.

**Speeds achievable by different technologies**

* USB 1.1 – 15 Mbps  
* FireWire (1394a) – 400 Mbps  
* USB 2.0 – 480 Mbps  
* FireWire 800 (1394b) – 800 Mpbs  
* SATA 1.5 – 1.5 Gbps  
* SATA 3.0 – 3.0 Gbps

**System board connectors of a PC:**

1. 9-pin male connector on system board is serial and usually COM 1 (mouse)  
2. 25-pin male connector on system board is serial and usually COM 2 (modem)  
3. 25-pin female connector on system board is parallel and usually LPT 1 (printer)

**Northbridge Southbridge Chipset**

The Northbridge chipset controls communications between the CPU, memory, PCI and AGP busses. The Southbridge actually uses the PCI bus to handle the I/O ports, USB and the IDE controller.

**Real Time Clock:**

The Complementary Metal-Oxide Semiconductor (CMOS) allows the computer to store the Real Time Clock (RTC) and other device information even after the computer is switched off and on. This is achieved by using a battery back, just for CMOS.
12. Security

Windows Vista\Windows 7 Security Center secures a PC by alerting when security software is out of date or when your security settings should be strengthened. The Security Center also displays your firewall settings and automatic updates are enabled or not.

Software is considered malware (malicious software) based on how the software is intended to be used. Malware includes computer viruses, worms, trojan horses, spyware, dishonest adware, and other malicious and unwanted software.

1. A boot sector virus stays resident by infecting the boot sector of the computer
2. A Master boot record (MBR) virus infect the first physical sector of all affected disks
3. File viruses either replace or attach themselves to executable files, and most commonly found virus.
4. Macro virus attaches itself to documents in the form of macros.
5. Memory viruses are viruses that execute and stay resident in memory. Trojan Horse is an example of memory virus.

A trojan is not a virus. The principal variation between a Trojan horse, or Trojan, and a virus is that Trojans don’t spread themselves. Trojan horses disguise themselves as valuable and useful software available for download on the internet. Trojan may work as a client software on your computer communicating with the Trojan server over the Internet.

Note that script files may include viruses hidden inside. Therefore, it is not wise to open any script file attachments such as file.scr or file.bat etc.
13. Miscellaneous

Cleaning of PC components – tools used:

Recommended cleaning procedures for various components are as below:
1. Computer Cabinet: Use Mild detergent
2. Dust inside the computer: Use Compressed air
3. Tape drive: Use tape drive cleaning cartridge
4. Floppy drive: Use Floppy drive cleaning kit
5. CD ROM drive: Use CD-ROM drive cleaning kit

IsoPropyl Alcohol is recommended for cleaning PCAs such as motherboards. Mild detergent can be used for cleaning the outside cabinet or the keyboard.

The following devices require periodic cleaning:
1. Floppy drives
2. Tape drives
3. Printers
4. Mouse

Tools - Screw driver types:

· A Flat blade screw driver has Minus slot
· A Philips screw driver has X shape slot
· A Torx screw driver has star tip or head
· A Hex screw driver has hex head

ESD:

- It is important to know that ESD damage may not be known immediately. A component may only suffer degradation in performance, which may show up only at a later date. In some cases, an ESD may result in the failure of the component instantly.
- When working on computers, use special ESD wrist strap. Do not directly ground yourself with a piece of wire. An ESD wrist strap has built-in resistor to prevent electric shock. Use specially designed grounded ESD mats. Do not wear synthetic clothing. Place all electronic components into anti static bags. Anti static bags can be reused. Keep your workplace clean.
- As the humidity decreases, static build up will increase. A level of 50% is considered safe. Below 50% humidity, static build up will be more.
- Electrostatic discharge (ESD) can damage the component at as little as 110 volts. CMOS chips are most susceptible to ESD.

Terminate and Stay Resident programs, as the name suggest, stay inactive in the memory area of the computer. An example of a TSR is Screen saver program. To view, which programs are consuming
how much memory area, **MEM command** can be issued with switch "C".

If you notice that the time is constantly incorrect, even after adjusting correctly, the most likely cause is that the **CMOS battery** has become weak and need to be replaced. Batteries, and chemical solvents contain environmentally hazardous chemicals and therefore, should not be disposed through dustbin. Always refer to the manufacturer's instructions or the relevant State guidelines.

**Power On Self Test (POST)** happens after the computer cold boots.

A computer may reboot because the CPU is overheating. Ensure that you have sufficient ventilation for proper airflow, and that the CPU fan is working.

The **Hibernate option** in Windows computer saves an image of your desktop, including all open windows and files. Then it powers down your computer just as if you had turned it off. When you turn your computer on again, your windows and files are open just as you left them. You can enable hibernate on a Windows computer by right clicking on the Desktop, the then selecting Properties.

The automatic restart option in Windows XP is enabled by default. As a result, if there is any major error, the Operating System will automatically restart. This can be disabled using System **applet** in the Control Panel.

Running a command like “ping” or “ipconfig” using Start -> Run, will open the command screen. However, the command screen closes soon after the execution of the command. If you intend to observe the results of any such command, you need to open the DOS screen by going to Program Files | Accessories | Command Prompt

It is recommended to close any open slots on a computer cabinet (case) to ensure proper airflow inside the case.

The file ntbtlog.txt file contains information collected if you choose to boot using “**Boot Logging**” startup option. The file shows which drivers are loaded and which have failed to load.

**Riser card** typically holds multiple IO cards.

When you observe any hardware damage with a PC, first turn-off and unplug the unit. Then the appropriate action would be to refer to the manufacturer’s documentation or website for warranty or maintenance information.
14. Others

1. IDE hard disks:
   - An IDE hard disk can have one Primary partition and one Extended partition. An Extended
     partition can be divided into one or more logical partitions. After partitioning the hard disk,
     each partition needs to be formatted.
   - The File System Boot Sector is the first physical sector on any logical volume.
   - The first physical sector on any bootable hard disk contains Master Boot Record, MBR.
   - The command FDISK will destroy all the data on a partition or drive on to which it is run.
   - The primary partition can be made bootable, by marking partition as active.

2. FAT:
   - Windows 98 and Windows 95 OEM Release 2 support FAT32. Note that Windows NT does
     not support FAT32. NT supports only FAT16 and NTFS. Windows 2000 supports FAT16,
     FAT32, and NTFS.
   - DOS standard FAT16 support drives up to 2 GB. FAT32 supports drives up to 2TB
     (Terabytes).

3. PC Utilities: The following DOS utilities are useful in proper maintenance of PCs.
   A. SCANISK: ScanDisk is a utility program that was added to DOS Version 6.0. SCANISK
      is a better compared to CHKDSK. SCANISK can fix errors on data storage devices such as
      hard disks, floppy disks, RAM drives etc, and DoubleSpace compressed drives. It analyzes and
      repairs damage to the following:
      1. Physical clusters
      2. File allocation table (FAT)
      3. Lost clusters
      4. Cross-linked files
      5. Directory tree
      6. MS-DOS Boot sector
      7. DBLSPACE volume header, file structure, compression structure.
   B. CHKDSK (Check Disk): CHKDSK command, one of DOS commands, examines your hard
      drive for error conditions and reports the total size of the disk, how many files are stored there,
      and the space remaining. CHKDSK also reports the total amount of conventional memory in
      your system and the amount of conventional memory available. Note that CHKDSK can't
report extended memory.

C. DFRAG: The DFRAG.EXE is included with DOS6.0 and later. DEFRAG utility arranges the clusters of data on the hard drive to achieve better performance by placing all of the clusters for a given file together in a contiguous order. DEFRAG does not do any repair on your disk, and errors, if any will remain on the disk.

D. BACKUP: DOS has a backup utility since version 2.0.

4. .COM, .EXE, .BAT files are executable files.

5. DOS Boot up:

- IMPORTANT DOS FILES USED DURING BOOT UP ARE:

A. AUTOEXEC.BAT
   - It does: Modifies the PC environment (PATH, SET, and other commands)
   - Default Attributes: Nil
   - Is it required for OS Start up: NO

B. CONFIG.SYS
   1. It does: Loads low level device drivers and does performance tuning
   2. Default Attributes: Nil
   3. Is it required for OS Start up: NO

C. IO.SYS
   1. It does: Loads basics Input/Output routines for the processor
   2. Default Attributes: Hidden / System/ Read Only
   3. Is it required for OS Start up: YES

D. MSDOS.SYS
   1. It does: Defines System File locations
   2. Default Attributes: Hidden / System/ Read Only
   3. Is it required for OS Start up: YES

E. COMMAND.COM
   1. It does: The file contains internal command set and error messages
   2. Default Attributes: Nil
   3. Is it required for OS Start up: YES
   4. Responsible for displaying the command prompt in a DOS based computer.
F. HIMEM.SYS
1. HIMEM.SYS must be loaded before EMM386.EXE
2. HIMEM.SYS is used to address the extended memory

G. EMM386.EXE
1. EMM386.EXE allows access to Upper Memory Area. Please note that the conventional memory of 1 MB is divided into 1. Lower Memory Area 640 KB, and 2. Upper Memory Area 384KB (1024KB-640KB).

H. ANSI.SYS
- The files AUTOEXEC.BAT, CONFIG.SYS, ANSI.SYS are not required for OS start-up. However, the files IO.SYS, MSDOS.SYS, COMMAND.COM are required for OS start-up.
- To bypass the CONFIG.SYS, and AUTOEXEC.BAT files during boot process of DOS, you need to press F5. F8 allows you to selectively bypass commands in AUTOEXEC.BAT, and CONFIG.SYS.

6. DOS allows you to set the following attributes using ATTRB command:
   1. System
   2. Hidden
   3. Read-only
   4. Archive

   '+' sets and attribute
   '-' clears an attribute

Examples:
- The command ATTRIB +H myfile.txt will make the file myfile.txt hidden. The other attributes that can be set using ATTRIB command are System, Read Only, and Archive.
- The command ATTRIB C:\private.txt +h +r will mark the file private.txt as both hidden and read only.

7. DOS, Windows3.1 Windows 95/ 98 operating systems have the following characteristics:
   1. Each can have only one primary partition per hard disk
   2. The primary partition is automatically assigned a drive letter
   3. Each hard disk can have only one Extended partition
   4. You can create one or more logical drives in the Extended partition.
   5. The drive letters are assigned manually to logical drives.
8. The standard DOS partition cluster sizes are as given below:

16MB-127MB: 2KB cluster size
128MB-255MB: 4KB cluster size
256MB-511MB: 8KB cluster size
512MB-1023MB: 16KB cluster size
1024MB-2048MB: 32KB cluster size

Note that due to DOS limitation, the FAT on each hard drive partition can have 64K (65535) individual addresses. Therefore, it is clear, depending on the size of partition, this number dictates the size of each cluster. We arrive at 32KB cluster size by dividing 2048(MB) with 64(KB).

9. The Windows 95/98 system files include the following:
   
   A. IO.SYS
   B. MSDOS.SYS
   C. WIN.INI
   D. COMMAND.COM
   E. SYSTEM.INI
   F. SYSTEM.DAT
   G. USER.DAT

- MSDOS.SYS, WIN.INI, SYSTEM.INI are text files.

- SYSTEM.DAT, USER.DAT files are part of windows Registry and can be edited using REGEDIT or REGDT32 utility. Registry files can't be read with standard text editors.

- Further, USER.DAT file corresponds to HKEY_LOCAL_USER and SYSTEM.DAT corresponds to HKEY_LOCAL_MACHINE.

10. HKEY_LOCAL_MACHINE is the hive where the information specific to the machine will be stored. The information may include, network settings, hardware drivers etc.

HKEY_LOCAL_USER hive stores data specific to user configuration, such as desktop color schemes, screen savers, wall paper, and user specific application settings.

11. Using FDISK, the following activities can be carried out:

   1. Create Partitions: You can create primary and extended partitions. Extended partition holds one or more (Up to 23) logical drives.

   2. Set Active Partition: FDISK allows you to mark the primary partition as active partition.

   3. Delete Partition: You can delete a partition by using FDISK
4. Display Partition Information.

12. DOS COMMANDS:

- MEMMAKER can be used to manage the system memory optimally. Windows 95 and above automatically manage the memory, whereas DOS requires manual memory management using utilities like MEMMAKER. The DOS command MEM can only display the contents of memory, but itself cannot manage the memory.

- When you power on the DOS machine, you see a message, "Starting MS-DOS". If you press F5 key during this short period, you can bypass AUTOEXEC.BAT and CONFIG.SYS files.

Given below are common DOS commands that you use frequently:

1. PATH: The command sets or displays a path for executable files. For example, "PATH=C:\; C:\DOS; C:\PROG; C:\MYFILES" command indicates DOS to first search ROOT, then C:\DOS, then C:\PROG, and finally C:\MYFILES for executable files.

2. SET: Displays, sets, or removes DOS environment variable.

3. PROMPT: Changes the DOS command prompt. The prompt can be made up of normal characters and the following special codes:

$p Current drive and path
$l < (less than sign)
$d Current date
$t Current time
$_ Carriage return

Syntax: PROMPT [text]

For example, to set the prompt to current date, followed by the current drive path, issue the command:

PROMPT= $p$d

13. The file load order to start DOS is:

- IO.SYS
- MSDOS.SYS
- CONFIG.SYS
- COMMAND.COM
- AUTOEXEC.BAT
- Note that CONFIG.SYS, and AUTOEXEC.BAT are optional to load DOS. IO.SYS, MSDOS.SYS,
14. When you format a disk with a "\s" switch (say “format a:/s”), the following files get transferred:

1. IO.SYS
2. MSDOS.SYS
3. COMMAND.COM

- If you want to format a drive and also make it bootable, you need to format with /s switch.

15. Windows 95:

- The minimum published requirements for running Windows 95 is 386 processor with 4 MB of RAM. Though it may be sufficient, the performance will be very poor and some applications may not run at all. A recommended configuration is a Pentium processor with 32 MB of RAM.

- Booting Windows 95 in safe mode loads the drivers for Keyboard, Mouse, and standard VGA graphics adapter.

- Windows 95 Version A supported only FAT16 file system. The maximum hard disk partition supported by FAT16 is only 2 GB. However, Windows 95 Version B and Windows 98 support FAT32 and therefore, can support partitions upto 2TB (Tera bytes).

- SYSTEM.DAT and USER.DAT comprise of Windows 95 Registry. These are the files where most of the user and system configuration information is stored. The Windows Registry files are stored in \Windows directory by default.

- Windows 95 makes a backup of the Registry after every successful reboot. The Registry back up files are named: USER.DA0, SYSTEM.DA0. The original Registry files are named: USER.DAT, SYSTEM.DAT. It may be noted, that in the event of boot failure, you can delete the original USER.DAT AND SYSTEM.DAT files and the back up files can be renamed to DAT files and the system can be rebooted successfully.

- While booting Windows 95, if you press F8, boot menu will be displayed. Windows 95 provides three different modes that the system can be started.

1. Normal Mode
2. Safe Mode
3. Command Prompt

- Normal Mode is the mode Windows 95 starts by default. It provides full functionality.

- Safe Mode is a diagnostic mode of Windows 95 that starts Windows 95 without any network, CD ROM, and other drivers. The only device drivers loaded in Safe mode are:
  
  o Keyboard
- Command Prompt mode is provided to run some old DOS applications that need to be run under DOS only. These applications are primarily the ones which access hardware, that Windows 95 does not allow to be accessed otherwise. Command Prompt mode is also useful for running FDISK and MSD.

- The log file BOOTLOG.TXT records all the devices and drivers that the Operating System attempts to load. BOOTLOG records the status of the devices and drivers.

- ScanDisk can be used to check disk drives for errors. The /f switch allows ScanDisk to automatically fix the errors.

- HKEY_CURRENT_CONFIG stores the hardware settings.

The six register keys available in Windows 95/98 Registry are:

A. HKEY_CLASSES_ROOT  
B. HKEY_CURRENT_USER  
C. HKEY_LOCAL_MACHINE  
D. HKEY_USERS  
E. HKEY_CURRENT_CONFIG  
F. HKEY_DYN_DATA

- Adding $ sign to the end of the share name makes the share invisible over the network.

16. Some important TCP/IP port numbers are as given below:

1. FTP: 21, stands for File Transfer Protocol
2. Telnet: 23, stands for Telnetting from a remote terminal to a Telnet Server
3. SMTP: 25, stands for Simple Mail Transfer Protocol
4. HTTP/WWW: 80, stands for Hyper Text Transfer Protocol
5. POP3: 110, stands for Post Office Protocol
6. HTTPS: 443, stands for HTTP Secure

17. User level security gives better control of resource on user-to-user basis. Share level security assigns passwords to the resources rather than the users and therefore less secure.

18. To pause the screen to view a large file, use |more switch. For example, to view autoexec.bat one screen at a time, type c:\autoexec.bat|more at the DOS prompt. Space bar can be used to go to next screen.
19. DNS stands for Domain Name System Server. DNS Server is the one responsible for converting the Domain names to IP addresses.

20. TSR stands for Terminate and Stay Resident. An example of TSR program is a virus detection program such as Norton Anti Virus.

21. If Autoexec.bat tried to access a drive letter that is not valid, the error message "Current drive is no longer valid" appears.

22. VIRUS:

   1. A boot sector virus stays resident by infecting the boot sector of the computer
   2. A Master boot record (MBR) virus infect the first physical sector of all affected disks
   3. File viruses either replace or attach themselves to executable files, and most commonly found virus.
   4. Macro virus attaches itself to documents in the form of macros.
   5. Memory viruses are viruses that execute and stay resident in memory. Trojan Horse is an example of memory virus.

23. TCP/IP

   - TCP/IP is the protocol used when you are Telnetting to a remote host. HTTP is used for accessing the World Wide Web services.
   - SMTP is used to upload mail to the mail server. POP3 is used for downloading mail from a mail server to a client machine running POP3 client.
   - Both PPP and SLIP can be used for dial up connections. However, SLIP can't be used where the IP address need to be assigned dynamically. The advantage of PPP is multi protocol support, that it can support TCP/IP, IPX, AppleTalk etc. SLIP can support only TCP/IP and IP addresses need to be assigned manually.
   - WINS server resolves the NetBIOS names to IP addresses. A Windows network running TCP/IP need to be configured with WINS (or LMHOSTS file on each computer) for NetBIOS name resolution.

24. Networking utilities:

   1. NBTSTAT: This utility displays current NetBIOS over TCP/IP connections, and display NetBIOS name cache.
   2. NETSTAT: Displays protocol statistics and current TCP/IP connections since the server was last booted.
   3. TRACERT: Used to determine which route a packet takes to reach its destination from source.
   4. IPCONFIG: Used to display Windows IP configuration information.
5. NSLOOKUP: This utility enables users to interact with a DNS server and display resource records.

6. ROUTE: Used to display and edit static routing tables.

25. Some of the important commands useful in troubleshooting TCP/IP networks are:

1. Ipconfig: Displays TCP/IP configuration values, including IP address, subnet mask, and default gateway.

2. Ping: This command can be used to verify whether the target IP address or host name is present. You need to specify the target IP address or host name. You can ping the loop back address at 127.0.0.1. A response ensures that the TCP/IP stack is installed properly on your computer.

3. Route: Displays and manipulates route information.

4. Tracert: Determines the route packets take to reach the specified destination.

26. To see TCP/IP configuration on a Windows 95/98 computer, use WINIPCFG. It will display your IP address, subnet mask, default gateway, hardware MAC address.

To see TCP/IP configuration on an NT machine, use IPCONFIG. It will also display the IP configuration information on an NT machine. To get more details, use IPCONFIG/ALL.

27. DLL stands for Dynamic Link Library. DLL is a special form of application code loaded into memory by request. A DLL is not executable by itself. More than one application may use the functions offered by a DLL.

28. HTML stands for Hyper Text Markup Language. HTML is the language most widely used for writing Web pages.

29. You can't apply file level permissions on a FAT file system. Only NTFS allows file permissions. Remember that the NTFS file permissions are always in effect to all users and processes.

30. PAP and CHAP:

- PAP uses 2-way handshaking. Passwords are sent in clear text across the link. Therefore, PAP is to be used only when it not possible to use CHAP.

- CHAP uses 3-way handshaking. CHAP uses Challenge/Response method, that provides protection against the password capture while authenticating the user. One should use CHAP whenever it is possible.

31. Windows 2000:

- Hardware requirements:
- When you install Windows 2000 in the same folder as that of Windows 95/ Windows 98/ Windows NT, the operating system gets upgraded to Windows 2000.

- TCP/IP protocol stack is installed by default when you install Windows 2000 on a computer.

- You can use Regional Options to support additional languages on your computer. With the support of additional languages, you will be able to edit documents written in those languages. You can also set locale specific to any region using this Option.

- The Windows 2000 Performance tool is composed of two parts:
  1. System Monitor, and
  2. Performance Logs and Alerts.

- With System Monitor, you can collect and view real-time data about memory, disk, processor, network, and other activity in chart (graph), histogram, or report form.

- Through Performance Logs and Alerts you can configure logs to record performance data and set system alerts to notify you when a specified counter's value is above or below a defined threshold.

- Event Viewer maintains logs about program, security, and system events. You can use Event Viewer to view and manage the event logs, gather information about hardware and software problems, and monitor Windows 2000 security events.

To open Event Viewer, click 'Start', point to 'Settings', and then click 'Control Panel'. Double-click 'Administrative Tools', and then double-click Event Viewer.

- Encrypting File System (EFS) keeps your documents safe from intruders who might gain unauthorized physical access to your sensitive stored data by stealing your laptop or Zip disk, or by other means.

You need to ensure the following before the upgrade:

1. The hardware is adequate for upgrading to Windows 2000 Professional
2. Also, check the hardware, software adequacy by running "Winnt32.exe /checkupgradenonly". Note that the switch “checkupgradenonly” will output a report on the adequacy of hardware and software. It will also warn you if any applications need upgrade.
packs, which may be obtained from respective application vendors, if available. If the software upgrade pack is not installed for any application, the application may be rendered unusable!

- If you are creating a Striped volume on a new Windows 2000 machine, it can only be created on dynamic disks. However, if you are upgrading a Windows NT computer to Windows 2000, any existing stripe set will be supported.

- For creating Stripe set with parity, we need at least 3 disk volumes.

- Placing the paging file on different physical disks is optimal. This will improve faster access to the Paging file, and also distribute the load.

- Microsoft Internet Explorer and Windows Explorer can be used for assigning Share and NTFS permissions on a Windows 2000 computer.

32. File names can be 255 characters long on a FAT, FAT32, and NTFS file systems.

33. Windows 2000 system monitoring:

Some of the important System Monitor counters are:

1. Memory>Available Mbytes: measures the amount of physical memory that is available. Typically > 4MB. If less than 4 MB, consider adding more memory.

2. Memory>Pages/Sec: Shows the number of times that the disk has been accessed, because requested information was not available in memory. If the value of the counter is not below 20, you should add more memory. A value of 4 or 5 is typical.

3. Paging File>%Usage: Indicates the % of allocated page file utilization. Should be less than 99%.

4. Processor>%Processor Time: measure the time that the processor is busy. Should be typically less than 80%

5. Processor>Interrupts/Sec: Indicates the average number of hardware interrupts that the processor receives each second. If more than 3,500, you can suspect a program or faulty hardware.

6. PhysicalDisk>%Disk Time: Measures the amount of time that the physical disk is busy servicing read or write requests. If more than 90%, you can improve the performance by adding another disk channel.

7. PhysicalDisk>%Current Disk Queue Length: indicates the number of pending disk requests that need to be processed. The value should be less than 2. The disk problems might arise from less memory, resulting in usage of excessive paging. Ensure that the memory is sufficient before attending to the disk problem.

8. LogicalDisk > %Free Space counter: Indicates the amount of logical disk’s free disk space. Typical value is 10% or above.
34. To insert a new file extension, you use Windows explorer, and select the application. Then, Tools -> Folder Option -> File Types. Configure the extension appropriately.

35. Windows 2000 disk volumes:

Windows 2000 Operating systems support 5 different volume types:

1. Simple volumes
2. Spanned volumes
3. Striped volumes
4. Mirrored volumes
5. RAID-5 volumes

A simple volume consists of a formatted disk on a single hard disk.

A Spanned volume consists of disk space on more than one hard disk.

A Striped volume has disk space on 2 or more disks. The disk spaces must be same on all disks. Fastest disk access among all volume types. RAID level 0.

A mirrored volume consists of a Simple volume that is mirrored in total, onto a second dynamic disk. Provides highest level of fault tolerance. Mirroring is RAID level 1

A RAID-5 volume consists of identical sized disk space located on three or more dynamic disks. Here any single disk failures can be recovered.


36. Fault tolerance boot disk is a floppy disk that enables you to boot a computer in the event that the first disk in a mirrored volume fails. If you mirror the installation folder in a Windows 2000 Server, you will not be able to boot because boot.ini points to the first volume. Therefore, you need to create a fault tolerance boot disk that contain an appropriately edited Boot.ini file, that points to the mirrored volume.

37. By default, you can start recovery console (in Windows 2000) using,

1. The Windows 2000 Professional Setup Disks
2. From the CD ROM drive using Windows 2000 Professional CD (if the CD –ROM drive is bootable).

Also, you can have “Recovery Console” as a start up option by typing \i386\winnt32.exe /cmdcons at the command prompt, after switching to the CD ROM drive letter.

38. Windows 2000 provides two versions of Registry Editor

1. Regedt32.exe (32-bit) and
2. Regedit.exe (16-bit).

Regedt32.exe is automatically installed in the systemroot\system32 folder, while Regedit.exe is automatically installed in the systemroot folder. Regedit.exe is primarily used for its search capabilities as it doesn’t support all functions and data types.

39. On a Windows 2000 computer, the default spool folder is located at: Systemroot\System32\spool\printers. For example, if the OS is residing on C drive, the default location will be: “C:\WINNT\System32\spool\printers”.

You can access this location through:
Start -> Printers -> File -> Server Properties -> Advanced tab. Type in the new spool location over the default location.

40. Up-grade to Windows 2000:
- You can upgrade Windows 95/98, Windows NT 3.51 Work Station, Windows NT 4.0 WS can be upgraded to Windows 2000 Professional.
- You can’t upgrade Windows 3.1 and Windows for workgroups to Windows 2000 Professional. If you need to install 2000 Prof. On Windows 3.x, you need to upgrade first to Windows 95/98 or NT and then upgrade to 2000 Prof. It is easy to do a clean install of Windows 2000 on Windows 3.x machines.

41. By default, Windows 2000 stores a user’s profile in the C:\Documents and Settings\ user_name folder on the computer the user logs on. When a new user logs on, his initial user profile is an exact copy of either the local or domain-wide “default user” profile folder. The local default user profile folder is located in %root\Documents and Settings.

If you have installed Windows 2000 in C drive, it is C:\Documents and Settings.

42. The Windows 2000 Performance tool is composed of two parts:
   1. System Monitor, and
   2. Performance Logs and Alerts.

With System Monitor, you can collect and view real-time data about memory, disk, processor, network, and other activity in chart (graph), histogram, or report form.

Through Performance Logs and Alerts you can configure logs to record performance data and set system alerts to notify you when a specified counter's value is above or below a defined threshold.

43. Pressing F8 during boot process in Windows 2000 desk top bring up the following options:
   1. Safe Mode
   2. Safe Mode with Networking
   3. Safe Mode with Command prompt
Safe Mode loads only the drivers necessary to get the desktop up and running. The drivers loaded with Safe Mode include mouse, monitor, keyboard, hard drive, and standard video driver.

Safe Mode with Networking is same as Safe Mode with networking enabled.

Safe Mode with Command Prompt option loads the command prompt instead of Windows 2000 graphical interface.

Enable VGA Mode option loads a standard VGA driver. This option is good if you have any problem with newly installed video driver.

Last Known Good Configuration enables the desktop to load the configuration that was stored when it was booted successfully last time. This option can’t take care of any hardware related problems.

The Debugging Mode option runs the Kernel Debugger, if that utility is installed.

The Boot Normally is same as not pressing the F8 key. The Windows boots normally.

44. You can access Task Manager by pressing <Alt> <Ctrl> <Del>. The applications tab lists all the applications that are currently running on the computer. The current status of the application is also displayed as either “Running” or “not responding” or “stopped”.

45. Blue screen messages are also called STOP messages. You will not be allowed to proceed, when a blue screen message appears. The most likely cause of blue screen messages are:

   1. Boot sector virus
   2. IRQ/ IO address conflicts.

You can check for any boot sector virus, and also for any conflicting IRQ / IO addresses.

46. You can configure support for multiple displays on your Windows 2000 computer. This is done through the use of Control Panel -> Display -> Settings. A Windows 2000 computer can support up to ten display monitors at the same time. Use additional video cards as required.

47. On a Windows 2000 computer, disk quotas can be used on NTFS volumes. Windows Explorer can be used to configure and monitor disk quotas.

48. On a Windows computer, you can use the View tab in Folder Options applet in the Control Panel to show / hide files and folders that have “Hidden” attribute set. You can also use Windows Explorer -> Tools -> Folder Options -> View tab.
49. If you want to install Windows 2000 on the same partition as that of Windows 98, install 2000 Professional either on the FAT file systems or on the FAT32 for dual boot. Windows 98 supports FAT (FAT16) and FAT32. It doesn’t support NTFS file system.

50. The various file systems supported by Windows 2000 are:
   1. FAT: Also called FAT16, supported by all Microsoft Operating Systems.
   2. FAT32: Also supported by Win 95 OSR2 and Win98
   3. NTFS: This is not supported by Win95/98
   4. CDFS (Compact Disk File System, used to access CDs)
   5. UDF (Universal Disk Format, used to access DVDs)

51. If you want to have dual boot between Windows NT 4 and Windows 2000, ensure that Service Pack 4 is installed on Windows NT 4. This is required since Windows 2000 upgrades the NTFS to NTFS 5. NT4 requires Service Pack 4 to read and write to NTFS 5.

52. If you encrypt a folder on an NTFS volume, all files and subfolders created in the encrypted folder are automatically encrypted. Therefore, it is recommended that you use encryption at the parent folder level.

   Also note that you can’t encrypt a file or folder that is compressed. If you want to encrypt a file or folder that is compressed, you need to first decompress the file or folder and then encrypt. Only NTFS volumes support file or folder encryption.

53. You don’t need to have a network card installed for successful installation of Windows 2000 Professional. You can use loop back adapter for this purpose and proceed with the installation. Network card can be installed at a later time, when required.

54. In Windows 2000 computer, Disk Management is used to create, manage, and delete simple volumes, spanned volumes, mirrored volumes, striped, and stripe set with parity volumes. Disk Administrator is NT 4 tool and is not available in Windows 2000.

55. Only Windows NT Server 4 and Windows NT Server 3.51 can be upgraded to Windows 2000 Server. Windows NT Workstation 4.0 or Windows 95/98 can't be upgraded to 2000 Server.

56. You can use System Monitor as well as Task Manager to monitor Processor and Memory usage on your Windows 2000 computer.
Abbreviations

SRAM - Static RAM
RAM - Random Axis Memory
DRAM - Dynamic RAM
PROM - Programmable ROM
ROM - Read Only Memory
BIOS - Basic Input/Output System
DIMM - Dual-Inline Memory Module
SIMM - Single-Inline Memory Module
SDRAM - Synchronous Dynamic Random Access Memory
EDO DRAM - Extended Data Output Dynamic Random Access Memory
DDR-SDRAM - Double Data Rate - Synchronous Dynamic Random Access Memory
PCMCIA - Personal Computer Memory Card International Association
ESATA - External Serial Advanced Technology Attachment
DVD - Digital Video Disc
PCI - Peripheral Component Interconnect
WXGA - Wide Extended Graphics Array
DSDD - Double Sided Double Density
DSHD - Double Sided High Density
DSED - Double Sided Extra Density
SXGA - Super eXtended Graphics Array
WSXGA - Wide Super-eXtended Graphics Array
UXGA - Ultra eXtended Graphics Array
WUXGA - Wide Ultra eXtended Graphics Array
PGA - Pin Grid Array
FAT - File Allocation Table
ATX - Advanced Technology Extended
UPS - Uninterruptible Power Supply
COM - Component Object Model
SCSI - Small Computer System Interface
USB - Universal Serial Bus
IRQ - Interrupt Request
ISA - Industry Standard Architecture
EISA - Extended Industry Standard Architecture
VESA - Video Electronics Standards Association
AGP - Accelerated Graphics Port
POST - Power-On Self-Test
TCP/IP - Transmission Control Protocol/Internet Protocol
IDE - Integrated Drive Electronics
CMOS - Complementary Metal-Oxide Semiconductor
PDAs - Personal Digital Assistants
SEC - Set Carry
FC-PGA - ‘Flip-Chip' Pin Grid Array
CGA - Color Graphics Adapter
VGA - Video Graphics Array
EGA - Enhanced Graphics Adapter
SVGA - Super Video Graphics Array